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Question: 1  
An application in Leopard has become unresponsive, and you wish to force the application to 
quit. Which THREE of the following are ways to Force Quit an unresponsive application in 
Leopard? SELECT THREE 
 
A. Press Command-Control-Eject 
B. Press Command-Option-Escape 
C. Choose Force Quit from the Apple Menu 
D. Control-click the application's icon in the Dock 
E. Press and hold the power button for ten seconds 
F. Press and hold the mouse button for ten seconds 
 
Answer: B, C, D 
 
Question: 2  
A customer would like to install Leopard onto a Mac with Mac OS X 10.2 Jaguar. What installation 
options will be available to this customer? SELECT ALL THAT APPLY. 
 
A. Upgrade 
B. Secure Install 
C. Erase and Install 
D. Archive and Install 
 
Answer: C, D 
 
Question: 3  
Which TWO of the following Macintosh Computers DO NOT support Leopard? SELECT TWO 
 
A. Mac Pro 
B. iBook G3 
C. Power Mac G5 
D. Power Mac G4 Cube 
E. PowerBook G4 (12-inch) 
 
Answer: B, D 
 
Question: 4  
After installing Windows on his Mac with Leopard using Boot Camp, a customer is unable to eject 
the Windows Installer CD from his optical drive. What should you tell this customer? 
 
A. The optical drive may have failed, and should be brought in for testing. 
B. Apple does not support Boot Camp and the customer should contact Microsoft for support. 
C. Until the customer installs the Mac drivers for Windows, he will be unable to use the eject key 

on his keyboard. 
D. The customer did not run the required firmware update and needs to do so before the optical 

drive will work with Windows. 
 
Answer: C 
 
Question: 5  
Which TWO of the following are supported ways of restoring a file or folder from a Time Machine 
backup in Leopard? SELECT TWO 
 
A. Manual restore through Finder 
B. Restore from the Time Machine interface 
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C. Time Machine Restore Utility in the Utilities folder 
D. Use the Restore tab in the Time Machine system preference pane. 
 
Answer: A, B 
 
Question: 6  
A customer using a Mac with Leopard complains that she set up a new user account in Accounts 
preferences, but that user does not appear in the Login Window. Which of the following is the 
most likely explanation for this? 
 
A. The user has a sharing only account. 
B. The user has attempted to log in too many times. 
C. The user has time limits applied that have expired. 
D. The user has parental controls applied that have been activated. 
 
Answer: A 
 
Question: 7  
Which one of the following combinations of network configurations would require multiple 
locations to properly configure? 
 
A. PPP dialup IP address with modem and DHCP IP address with AirPort. 
B. DHCP IP address with built-in Ethernet and DHCP IP address with AirPort. 
C. PPP dialup IP address with modem and fixed IP address with built-in Ethernet. 
D. Fixed IP address with built-in Ethernet and DHCP IP address with built-in Ethernet. 
 
Answer: D 
 
Question: 8  
Leopard supports the creation of groups to manage permissions for multiple user accounts. 
 
A. True 
B. False 
 
Answer: A 
 
Question: 9  
Examine the exhibit.  

 
 
What does this symbol mean when starting Leopard? 
 
A. The Mac is unable to find a startup disk that contains boot files. 
B. The Mac cannot identify one or more folders on the hard disk. 
C. The Mac cannot identify one or more files on the hard disk. 
D. The Mac is unable to find the Classic environment. 
 
Answer: A 
 
Question: 10 
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A customer complains that the image on her MacBook's display is too large and distorted. Which 
of the following would be the best suggestion to resolve this issue? 
 
A. Open Display preferences and change the display resolution. 
B. Adjust brightness control to a more optimum setting. 
C. Restart the MacBook in Verbose Mode. 
D. Replace the display assembly. 
 
Answer: A 
 
Question: 11 
You can reinstall bundled printer drivers from the Leopard installation disc. 
 
A. True 
B. False 
 
Answer: A 
 
Question: 12 
Leopard File Sharing allows files to be shared in folders other than the user's Public folder. 
 
A. True 
B. False 
 
Answer: A 
 
Question: 13 
Which conditions must be met for you to be able to connect to a remote "Back to My Mac" 
enabled computer? (SELECT ALL THAT APPLY) 
 
A. You have a .Mac account. 
B. The remote computer must be awake. 
C. Your computer has "Back to My Mac" enabled. 
D. Remote computer has "Back to My Mac" enabled. 
E. Your Time Machine Backup Disk must be connected. 
 
Answer: A, B, C, D 
 
Question: 14 
Which ONE of the following volume formats is required for use on a Time Machine backup drive? 
 
A. Mac OS Standard 
B. Mac OS Extended 
C. FAT-32 
D. NTFS 
E. UFS 
 
Answer: B 
 
Question: 15 
Which application provides the most detail about system processes in Mac OS X v10.5? 
 
A. System Profiler 
B. Activity Monitor 
C. Process Manager 
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D. CPU Monitor Expanded Window 
 
Answer: B 
 
Question: 16 
Which of the following scenarios is most appropriate to use Repair Permissions in Disk Utility? 
 
A. Cannot open one Numbers document. Other Numbers documents open without issue. 
B. Cannot install any application into /Applications. 
C. Cannot completely erase and install Leopard. 
D. Computer fails to turn on. 
 
Answer: B 
 
Question: 17 
In order to install Leopard, the Mac must have at least _____ . 
 
A. One processor running at 667 MHz 
B. One processor running at 867 MHz 
C. Two processors running at 667 MHz 
D. Two processors running at 867 MHz 
 
Answer: B 
 
Question: 18 
The startup sequence for Leopard is broken into three major sections. In what order do the 
following three stages occur? 
a.Startup 
b.Hardware 
c.Login 
 
A. a-b-c 
B. b-c-a 
C. c-b-a 
D. b-a-c 
E. c-a-b 
 
Answer: D 
 
Question: 19 
What should you look for when quickly checking Leopard's Network preference for proper 
network configuration? 
 
A. Verify the preference pane is unlocked. 
B. Click the Advanced button and verify that no proxies are enabled. 
C. Look for the color of the dot next to the expected network port. 
D. Look for the presence or absence of a dot next to the expected network port. 
 
Answer: C 
 
Question: 20 
Which three of the following drive types are supported by Leopard for Time Machine backups? 
SELECT THREE 
 
A. iPod 
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B. XSAN volume 
C. Dot Mac iDisk 
D. Internal non-startup volume 
E. External USB, FireWire, or eSATA drive 
 
Answer: B, D, E 
 
Question: 21 
In Leopard, a Sharing Only account on your Mac can only _____. 
 
A. Access the Shared folder to store files 
B. Be used to access your Mac over a network 
C. Be used to share this account with other users 
D. Be used for guests to access your Mac from the login screen 
 
Answer: B 
 
Question: 22 
How can a user delete a file named "junk document" from all previous backups? 
 
A. Delete "junk document" in the Time Machine Finder window for the most recent backup. 
B. Open Time Machine preferences and remove the file "junk document" from the backup list. 
C. Select the "Delete all Backups of "junk document" from the File menu in any standard Finder 

window. 
D. Select the "Delete all Backups of "junk document" from the Action menu in the Time Machine 

Finder window. 
 
Answer: D 
 
Question: 23 
 Examine the exhibit.  

 
What does this symbol mean when starting Leopard? 
 
A. The Mac failed its power on self-test. 
B. The Leopard kernel could not continue executing. 
C. This version of Mac OS X is not compatible with this Mac. 
D. The Leopard Security Module discovered a virus and blocked it. 
 
Answer: B 
 
Question: 24 
Examine the exhibit.  
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On a Mac OS X v10.5 computer you see the message shown in the exhibit. What does this 
message indicate? 
 
A. A kernel panic has occurred. 
B. An application has stopped responding. 
C. You have pressed the power button while the computer was powered up. 
D. You have connected a bus-powered device that requires more power than is available. 
 
Answer: A 
 
Question: 25 
Which of the following System Preferences contains settings to configure the built-in firewall in 
Leopard? 
 
A. Sharing 
B. Security 
C. Network 
D. Accounts 
 
Answer: B 
 
Question: 26 
When Time Machine creates incremental backups, how are the files organized? 
 
A. Version numbers (1.1,1.2,1.3) 
B. Date and time (yyyy-mm-dd-hhmmss) 
C. Date and time (mm-dd-yyyy-hhmmss) 
D. Version numbers (1a,2b,3c) 
 
Answer: B 
 
Question: 27 
Which is a valid troubleshooting step to resolve a customer's complaint that his Time Machine 
backup takes a long time? 
 
A. Quit unused applications. 
B. Purchase a larger backup drive. 
C. Reselect the drive as your backup drive. 
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D. Remove non-Time Machine files from your backup drive. 
 
Answer: A 
 
Question: 28 
If you choose to have multiple active ports, place the _____ port at the top of the list to give it the 
highest priority. 
 
A. Modem 
B. Wireless 
C. Highest bandwidth 
D. Most frequently used 
 
Answer: D 
 
Question: 29 
You may enable Parental Controls for guest users in Leopard using the "Enable Parental 
Controls" check box option in the Accounts pane of system preferences. 
 
A. True 
B. False 
 
Answer: A 
 
Question: 30 
In order to perform an erase and restore from a Time Machine backup you should _____. 
 
A. Boot to the Leopard Installer DVD and use the Restore function in Disk Utility. 
B. Boot to the Time Machine backup folder and use the Restore function in Disk Utility. 
C. Boot to the Leopard Installer DVD and use the "Restore System From Backup" utility. 
D. Boot to the Time Machine backup folder and use the "Restore System From Backup" utility . 
 
Answer: C 
 
Question: 31 
When Maria starts up her Mac with Leopard, a utility she recently installed launches and disables 
the mouse and keyboard. How can Maria prevent the utility from automatically launching? 
 
A. Hold down the V key while the computer starts up. 
B. Hold down the Shift key while the computer starts up. 
C. Hold down the Option key while the computer starts up. 
D. Log in as another user, and use Disk Utility to repair permissions on the startup volume. 
 
Answer: B 
 
Question: 32 
In Leopard, you can copy and paste Parental Control settings between users by using the _____. 
 
A. Copy and paste options from the Edit menu 
B. Parental Controls preferences 
C. Sharing preferences 
D. Security preferences 
 
Answer: B 
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Question: 33 
You can use _____ to look at the messages and log files sent and received by your Mac with 
Leopard. 
 
A. Console 
B. Disk Utility 
C. Activity Monitor 
D. System Profiler 
 
Answer: A 
 
Question: 34 
Starting up a Mac with Leopard in Verbose mode is useful when troubleshooting _____ issues. 
 
A. Login 
B. Startup 
C. Installation 
D. Networking 
 
Answer: B 
 
Question: 35 
Your customer wants to quickly build a list of all applications and extensions installed on his Mac 
with Tiger before upgrading to Leopard. Which of the following would be the best choice to do 
this? 
 
A. Finder 
B. Console 
C. System Profiler 
D. Directory Utility 
 
Answer: C 
 
Question: 36 
While troubleshooting a customer's Mac with Leopard, you want to try new network settings, but 
you don't want to disrupt the customer's existing settings. What can you do to achieve both 
goals?  
 
A. Delete all .plist files related to networking. 
B. Create and switch to a new network location. 
C. Reinstall Leopard and set yourself up as the new user. 
D. Select Override Network Settings in Network preferences. 
 
Answer: B 
 
Question: 37 
To configure printers in Leopard use the _____. 
 
A. Print and Fax Preference Pane in System Preferences 
B. Printer Setup Utility located in /Applications/Utilities/ 
C. Print Pool feature from the File menu 
D. Chooser 
 
Answer: A 
 



Exam Name: MAC OS X 10.5 Troubleshooting Exam 
Exam Type: Apple   
Exam Code: 9L0-061 Total Questions: 59 
 

Page 9 of 14   

 

Question: 38 
If a Macintosh computer continually boots into verbose mode, or single user mode, the first step 
that should be taken is _____. 
 
A. Perform an archive and install 
B. Reset the NVRAM/PRAM 
C. To suppress login items 
D. Reset the PMU 
 
Answer: B 
 
Question: 39 
A customer is backing up a computer named "Cliffords MacBook" to an external hard drive 
named "Big Drive" using Time Machine. What path is the backup stored in? 
 
A. /Cliffords MacBook/Backups.backupdb/Big Drive/ 
B. /Big Drive/Backups.backupdb/Cliffords MacBook/ 
C. /Cliffords MacBook/Time Machine/backups/Big Drive/ 
D. /Big Drive/Time Machine/backups/Cliffords MacBook/ 
 
Answer: B 
 
Question: 40 
A customer would like to install Leopard onto a Mac with Mac OS X 10.4 Tiger. What installation 
options will be available to this customer? SELECT ALL THAT APPLY. 
 
A. Upgrade 
B. Secure Install 
C. Erase and Install 
D. Archive and Install 
 
Answer: A, C, D 
 
Question: 41 
Which of the following is the best way to check for basic network connectivity from a known good 
Mac OS X operating system? 
 
A. Perform an erase and install then use Network Utility. 
B. Perform an archive and install, then use Network Utility. 
C. Use Network Utility while started from any Mac OS X system. 
D. Start up from the Mac OS X Install disc, then use Network Utility. 
 
Answer: D 
 
Question: 42 
In order to temporarily extend the time limit of a managed user in Leopard you must _____ and 
_____. SELECT TWO 
 
A. Log out of the managed user 
B. Be logged in as the managed user 
C. Use an administrator name and password 
D. Send an instant request via iChat to the admin user 
 
Answer: B, C 
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Question: 43 
Which statement about FileVault is TRUE? 
 
A. Once a user enables FileVault, it cannot be disabled. 
B. FileVault can only be enabled on non-administrator user accounts. 
C. There is no way to recover a user's data from a FileVault-protected account if the login 

password is lost. 
D. When a user enables FileVault, the user's home directory is transformed into an encrypted 

disk image bundle. 
 
Answer: D 
 
Question: 44 
Examine the exhibit.  
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When troubleshooting a customer's inability to send outgoing mail, you see these settings. What 
is most likely the reason for this customer's inability to send mail? 
 
A. Dot Mac is not an IMAP compatible service. 
B. The settings are correct; it is likely an issue with the ISP. 
C. There is a punctuation issue in the outgoing mail server. 
D. The Dot Mac account is a free trial and is unable to send mail. 
 
Answer: C 
 
Question: 45 
Which of the following should you always run after an archive and install of Leopard? 
 
A. System Profiler 
B. Software Update 
C. Network Assistant 
D. Migration Assistant 
 
Answer: B 
 
Question: 46 
How do you start up a Mac OS X computer in single-user mode? 
 
A. Restart while holding down Command-S. 
B. Restart while holding down Command-Option-S. 
C. Choose "Restart in single-user mode" from the Apple menu. 
D. Select Single-User Mode in the Startup Disk preferences, and restart. 
 
Answer: A 
 
Question: 47 
How can you check the battery level on an Apple Bluetooth Keyboard or Apple Bluetooth Mighty 
Mouse? 
 
A. Wait until the device stops responding. 
B. Observe LEDs on the devices themselves. 
C. Open the Bluetooth tab in Energy Saver preferences. 
D. Open the Bluetooth tab in Keyboard & Mouse preferences. 
 
Answer: D 
 
Question: 48 
Which THREE of the following are features of Leopard's new Parental Controls Time Limits? 
SELECT THREE 
 
A. Bedtime 
B. Application time limit 
C. Weekday time limit 
D. Weekend time limit 
E. Holiday limit exception 
 
Answer: A, C, D 
 
Question: 49 
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If you need to reinstall just a single bundled Leopard application such as Mail, you can do this by 
_____. 
 
A. Performing an Archive and Install using the Leopard installation disc 
B. Performing a custom Leopard installation selecting just that application 
C. Running the Optional Installs package from the root level of the Leopard installation disc 
D. Copying the application from the Leopard installation disc to the /Applications folder on the 

Mac 
 
Answer: C 
 
Question: 50 
You can only view Leopard's installation log during installation. After installation completes, the 
log is deleted. 
 
A. True 
B. False 
 
Answer: B 
 
Question: 51  
Before installing Leopard onto a Macintosh Computer you should ensure _____ and _____. 
SELECT TWO 
 
A. The system has at least 1GB of RAM 
B. The system has at least 512 MB of RAM 
C. The graphics card has at least 32MB of RAM 
D. The hard drive has at least 4GB of available space 
E. The hard drive has at least 9GB of available space 
 
Answer: B, E 
 
Question: 52 
A customer's Mac with Leopard has lost wired Ethernet connectivity to her school's DHCP 
network. Which of the following is the best first step to take to resolve her issue? 
 
A. Replace the Mac's logic board. 
B. Reinstall Mac OS X Leopard and all updates. 
C. Use Network Diagnostics to help isolate the failure. 
D. Assign a similar manual address to regain connectivity. 
 
Answer: C 
 
Question: 53 
Examine the exhibit.  
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Which stage in the startup process is this MacBook Pro with Leopard currently in? 
 
A. BootX 
B. boot.efi 
C. launchd 
D. EFI loading 
 
Answer: B 
 
Question: 54 
Which of the following is a good technique to use to verify if a Leopard software issue is specific 
to a single user? 
 
A. Restart in Single User mode. 
B. Delete and re-create all users. 
C. Create and log in as a new user. 
D. Allow the user to administer the computer. 
 
Answer: C 
 
Question: 55 
Which THREE security options can you configure in Leopard Security preferences? SELECT 
THREE 
 
A. Limit Concurrent Logins 
B. FileVault Master Password 
C. Use Secure Virtual Memory 
D. Allow Login for Admin Users Only 
E. Firewall Connections and Services 
 
Answer: B, C, E 
 
Question: 56 
After installing Leopard on her Mac and restarting for the first time, a customer is concerned 
about the length of time that her computer is spending on the spinning gear. What should you tell 
this customer? 
 
A. The verification process can take a long time on large drives. Allow the machine to finish 

booting, and the issue should not reoccur. 
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B. The startup disk has irreparable directory damage. Inform the user to perform an erase and 
install. 

C. The hard drive is failing. Inform the user to backup their data and have the drive replaced. 
D. The user files are set as "Sharing Only" which prevents login from taking place. 
 
Answer: A 
 
Question: 57 
Computers shared via "Back to My Mac" are NOT expected to appear for Parental Controls 
remote configuration. 
 
A. True 
B. False 
 
Answer: A 
 
Question: 58 
A customer claims he successfully performed a .Mac sync with his Leopard computer. When he 
performs a .Mac sync with a Tiger computer running 10.4.6, the computer displays a .Mac sync 
error. Which of the following is the best suggestion to resolve this issue? 
 
A. Upgrade the Tiger computer to Leopard. 
B. Update the Tiger computer to the latest version of Tiger. 
C. Perform a manual sync using iSync on the Tiger computer. 
D. Manually copy the sync file from the Leopard computer to the Tiger computer. 
 
Answer: B 
 
Question: 59 
What is different between a guest account and a standard user account in Leopard? 
 
A. A guest can only use the computer for a limited amount of time. 
B. A guest account's home directory is deleted when the guest logs out. 
C. A guest account's home directory is available to any guest who logs in. 
D. A guest is asked to supply a temporary password, a standard user is not. 
 
Answer: B 
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